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Training Workbook

Use this workbook to follow along with "Organize Your Business & Life - OneNote 
Video Training", by Business Made Simple.  Take notes, jot down ideas, and keep this 

for quick reference as you begin to learn the many uses of OneNote.

      

©2015 Business Made Simple and OneNote Made Simple are trademarks of Almost Anything LLC



It can help you organize your business, reference information, reminders, 
plans, projects, computer files and pretty much your whole life...

Eye 
appt

OneNote can help manage just about everything…

Some things I'd like to organize are:

Why Use OneNote?

      



Some things that OneNote is good for:

Shared communications○

Keeping everyone on same page•

Customer notes, time sheets, calendars, passwords○

Easy access and sharing of company information •

You can create a template for this○

Meeting minutes •

Another good way to use templates○

Project Management •

Marketing, operations, finance, etc.○

Company mission statement, goals and plans•

To Do Lists for home, office, community activities•

Personal notes and reminders•

Product & Service information and specifications•

Reference & Resource information•

Other great uses for OneNote:

Policy manuals•

Personnel reviews•

Procedures and workbooks •

Webinar and training notes•

Recipe Book•

Vacation planner•

Medical history•

See the last pages in this workbook for more ideas for using OneNote at work, home, and school.

What OneNote is not:
A Database (can't sort and run reports)•
An Excel Spreadsheet - although can embed one or link to one •

OneNote Uses

      

http://blogs.office.com/b/microsoft-onenote/archive/2011/12/08/hodgepodge-two.aspx


OneNote is divided into:

Subpages

Pages

Sections

Section Groups

Notebooks

Think of it as an electronic form of a very flexible notebook where pages and sections are as 
long or short as you need them to be and where they can be moved around at any time.

OneNote Layout

      



Spend some time brainstorming  the possibilities for sharing 
and storing information in a way that makes the most sense 
for your business and your life...

There's no right answer for how many is the right amount.  It really depends on things like:

Who will use the notebook?◊

How much information will collect over time? ◊

How easy will it be to navigate the sections and pages to find what you need?◊

Notebooks that would be useful to me:

How Many notebooks do you need?

      



The first time you use OneNote you'll be prompted to fill out your name and then a default example 
notebook will open up.  You can create a new notebook from the File tab. 

Section groups and sections show up on the left side, pages on the right.

Getting Started

      



Which notebooks are open, notebook settings, share settings,  sync setting,  open backup  

Info

To open a notebook that is not already open

Open

Create a new notebook.   Can choose how to share it:  web/network/just you

New

Change the sharing of any notebook.

Share

Can save in various formats such as Word or pdf.

Save as

Send as e-mail to someone or to your blog.

Send

Print or print preview.   

Print

Easy access to tutorials, articles and shortcuts.

Help

Options for customizing OneNote.   Suggest operations or IT manager select suggested 
"company options" and set up on each OneNote.

Options

Another way to close OneNote

Exit

File Tab Options

      



This is where you will work from most of the time.

When a tab is selected, the ribbon changes, but not the notebook.

Once you create a page, you can start typing anywhere.

Clipboard○

Basic Text○

Styles○

Tags○

Outlook○

5 Main Home Tab Sections

Clipboard functions
Cut

Copy

Paste

Format Painter

You can create separate text boxes and move them around easily.

Home Tab Options

      



Styles   allows you to quickly select common formatting.

Tags can help you locate prioritized things to do.
Tags allow you to categorize. 
The Checkboxes are a favorite.
You can have more than one tag.
You can create your own tags.

E-mail pages directly from OneNote

Assign an Outlook task to a note.

Tags

Outlook

A tag is a way to label a word or picture in order to identify it and find it later on.
It's a way to categorize your information.

Home Tab Options

      



Insert Space:   Insert or remove writing space.

A useful tool for inserting or reducing white space.

This can be helpful to gain more room on your note page.

Table:

Images:
Picture

Screen Clipping

Links:
Link text or picture to a website or another place in OneNote.

Files:
Insert a link or the actual text. Scan anything into OneNote. 
Everything becomes searchable.

Recording:    
Record audio or video.

Insert Tab

Time Stamp:
A shortcut for entering dates and times.  Perfect for timesheets.         

Symbols:
Easy way to insert symbols.   For example, use for the copyright symbol (©).

Insert Tab Options

      



Microsoft OneNote 2010

Microsoft OneNote 2013

Microsoft OneNote 2007

Share Tab (in each version)

      



These are the things you can do under the Share Tab:

E-mail a page to someone◊

Create a Shared Notebook or Share one that's already created◊

See what edits have been done in OneNote◊

Find who authors are◊

Search what else author has written◊

Look at additional history such as version and recycle bin◊

Share Tab

      



E-mail a page to someone     NOW JUST ON THE HOME TAB•

Create a Shared Notebook or Share one that's already created  IN THE FILE TAB•

See what edits have been done in OneNote•

Find who authors are•

Search what else author has written•

Look at additional history such as version and recycle bin•

Save As on the File Tab is now called Export•

Full Page View - great new tool•

} NOW ON HISTORY TAB

No Share Tab in 2013

      



By sharing notebooks on the web or on your network, other people can 
work on the same notebook at the same time

All web notebooks are shared through Microsoft SkyDrive

Sharing Notebooks

      



Erase portions of shapes▪
Lasso Select▪
Panning Hand - scroll easier within OneNote▪
Pens & Highlighters▪

Tools

Insert Shapes
Insert basic shapes quickly and easily.  Select line thickness and color too.

Use the Draw tab to highlight using  
free hand.   Use the Home tab to  
select text and highlight evenly.

Edit
Insert space (same as on Insert tab)
Delete anything you select
Arrange front to back
Rotate items

Convert
Convert ink to text, or ink to math symbols

Draw Tab Options

      



You can scroll way to the 
right or left, and up and 

down, by using the panning 
hand which can be quicker 

than the scroll bars.

Panning Hand

      



Check spelling of page or section.•

Spelling

Quickly research a topic on the internet•

Look up a definition•

Use a Thesaurus•

Research

Översätta till andra språk.•

Select language options.•

How are you?

Language

Online Bilingual Dictionary

how
wie; how are you? wie geht es dir?; how about ...? 
wie stehts mit ...?, wie wäre es mit ...?; how do you 
do? bei der Vorstellung: guten Tag!; how much? 
wie viel?; how many wie viele?

The Language tools are useful when writing advertising and 
promotional materials for global markets or when working with 
international customers or branch offices.

Review Tab

      



Take notes on the side of a webpage, PowerPoint 
presentation, another OneNote page, or any other 
window.

•

These notes will be automatically linked to the item 
you are looking at.

•

Linked Notes

Webinars•
Documents•
Manuals•
Videos•

Review Tab

      



Views
Can toggle full page view from Quick Access Toolbar   

Authors
Click on Hide Authors to see Authors initials.  
Click again to hide the authors.
If no initials - you are the author.

Page Setup
Page Color  (does not print)
Rule Lines (these do print)
Hide Page Title (deletes it)
Paper Size (and margins)

Zoom
Zoom in/out for easy viewing

Window
New Window creates an entire copy of the OneNote Window - great for two projects at once
New Docked Window - good for taking notes
New Side Note (temporary) - can also use Sticky Notes
Keep on top if use more than one window

Customize your Quick Access toolbar through Options or through the Quick Access toolbar itself.

View Tab: Views

Normal view displays the navigation bars and the feature ribbon

Full Page view hides the navigation bars & the ribbon for a clear view 
of your page



Dock to Desktop docks it to the side of your desktop so you can work 
in other programs while still having your notes open.    



View Tab

      



When you click on Hide Authors, the initials disappear.

View Tab:  Hide Authors

      



Add some color to your page!

Add some grids or lines to your page...

Have Fun!

Page Options

      



OneNote Mobile - Droid & IPhone

Video about OneNote:
http://microsoft.com/showcase/en/us/details/f95fca1d-
e3f9-4709-9dfe-5fc982906771

Write a book

Friday, February 17, 2012
1:32 PM

OneNote automatically enters date
and time created.  You can delete them.

Additional Functions/Features

      

http://microsoft.com/showcase/en/us/details/f95fca1d-e3f9-4709-9dfe-5fc982906771
http://microsoft.com/showcase/en/us/details/f95fca1d-e3f9-4709-9dfe-5fc982906771


Don't be afraid of OneNote.►

You can't break it.►

Worst case scenario - you delete something.   ►

If you do, click undo ►

Summary

      



Microsoft Office:•
Changes from 2007 to 2010 to 2013
http://technet.microsoft.com/en-us/library/cc179096.aspx#BKMK_New

Business Made Simple with Microsoft OneNote Blog:•
http://onenotemadesimple.com/2012/11/10/improvements-in-onenote-comparing-200720102013/

OneNote References
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Daily Tasks•

Copy of Business Plan○

Strategic Goals○

Copy of important documents (Articles of Incorporation or Organization) ○

Financial snapshots○

Keep mission statement in front of employees○

Corporate Books that have•

Password Log (sections can be secured)•

Customer Profile○

Standardized Forms such as:•

Policy Manuals & Employee Handbooks•

Step-by-step process for job tasks○

Procedure Manuals including:•

Training○

New Hire Procedures & Checklists○

Checklists for:•

Can easily track and send back and forth to team members○

Project Management•

Product Sheets•

Tracking Domain Names○

Product Features and Benefits○

Trade Show Checklists○

Marketing•

Profiles & Call Notes○

Agreements○

Policies○

Track customer requests○

Customer Data•

Meeting Notes •

Resources & Research including copies of websites and links to external articles•

Training Programs•

E-Guides•

Regulatory Issues•

OneNote for Work

      



Regulatory Issues•

Infographics•

Ideas & Thoughts - Brainstorming•

Flow charts•

List of all computer equipment and software○

Registrations and license information○

Links○

Repair and troubleshooting○

IT Notebook•

OneNote for School
Class Notes (can be taken right in class on a tablet, laptop or smart phone)•

School Year Schedules & Deadlines•

Track credits needed for degree completion•

Reports & Projects•

Research Projects•

Career research•

      



Chore list/table•

Daily Tasks•

Upcoming events linked to calendar (Outlook)•

Grocery List Template•

Clinic locations, doctors and phone numbers○

Medication Charts○

Allergy List○

Health History○

Appointment Records○

Insurance information (numbers, co-pay, premium, etc)○

Tables for tracking medications & vitals○

Medical Information including•

Dental Log•

Meal Planning & Recipes•

Make a checklist of what you want to accomplish in your life○

Dreams & Life Lists•

Visualization Board•

Address & Phone Number Lists•

Christmas and Birthday Lists•

Theme ○

Checklists with timeframes○

Guest List○

Food / Menu○

Cleaning List○

Grocery List○

Party Organization•

Write a Book•

Poetry•

Journal•

When and where purchased○

When shots○

Photos as they grow○

Pet Log•

Travel Planning•

OneNote for Home

      



Checklists○

Itineraries○

What to pack○

Flight/Hotel Arrangements○

Directions○

Budget / Costs ○

Travel Planning•

Spring and Fall Cleanup Checklists○

Reminders to change light bulbs, filters and batteries○

Yearly Home Maintenance•

Ideas & Thoughts•

Wedding Planner•

Budgets & Financial Data•

In Case of Death (important information your spouse/family should know)•

      



ONENOTE MADE SIMPLE

For additional resources and learning tools, visit our blog at

www.onenotemadesimple.com

For comments, suggestions or questions, please e-mail us at

heartofonenote@gmail.com
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